
 
NetVanta Unified Communications Technical Note

Best Practices for Integrating NetVanta UC 
Server with Microsoft Exchange Server
Introduction 

NetVanta UC Server is a real-time communications system that integrates with Microsoft® Exchange 
Server (2000, 2003, 2007, 2010, and 2013 SP1 (or later)) to provide Unified Messaging functionality. This 
technical note highlights the real-time requirements of Unified Messaging, and outlines principles and best 
practices when integrating with Microsoft Exchange Server.

The integration of NetVanta UC Server with Microsoft Exchange Server requires Microsoft's Messaging 
Application Programming Interface (MAPI) libraries to be present on the same computer as the NetVanta 
UC Server. Additional Microsoft Outlook forms can be installed on client computers to provide a 
specialized view of voice and fax messages beyond what Outlook supports for emails attachments. The 
Outlook forms use both MAPI and Outlook programming interfaces to perform these functions.

This document describes the behavior and characteristics for NetVanta UC Server versions 4.2 and later. 
Previous versions differ in functionality and characteristics.

Prerequisites

NetVanta UC Server provides Unified Messaging functionality on the Exchange Server using Microsoft's 
MAPI as the interface. This requires that MAPI be installed on the same computer as the NetVanta UC 
Server. ADTRAN recommends using the MAPI/Collaboration Data Objects (CDO) package from 
Microsoft. Alternatively, you can also install some versions of Microsoft Outlook on the NetVanta UC 
Server computer. If using Microsoft Outlook, ensure that you follow the minimum requirements as 
described in the NetVanta UC Server release notes and NetVanta Unified Communications Server Planning 
and Deployment Guide available from the ADTRAN Support Community 
(https://supportforums.adtran.com).

In NetVanta UC Server software version 4.5, support for Microsoft Exchange 2010 was 
added. In NetVanta UC Server software version 5.5, support for Microsoft Exchange 2013 
was added, and support for Microsoft Exchange 2000 and 2003 was removed. 

NetVanta UC Server version 5.5.0 (or later) can only be integrated with Microsoft 
Exchange Server 2007, 2010, or 2013 SP1 (or later) using MAPI CDO 1.2.1. Exchange 
Servers 2000 and 2003 are no longer supported. Additionally, the Microsoft Outlook client 
is no longer supported for Exchange Server integration.

https://supportforums.adtran.com/docs/DOC-2612
https://supportforums.adtran.com/docs/DOC-2612
https://supportforums.adtran.com
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ADTRAN does not support the installation of MAPI with the Microsoft Exchange Server management 
tools.

There are known issues with certain versions of MAPI, and it is important that the correct versions are 
installed. Consult the release notes provided with NetVanta UC Server for details on supported versions.

Integration

Privileged Mailbox Access Technique

In order for NetVanta UC Server to gain access to user mailboxes, it must be granted sufficient privileges 
to do so. This is done by first designating a special service account on the Microsoft Windows® domain, 
then creating an Exchange mailbox for the special service account user. Privileges are granted to this user 
to open all other user mailboxes to which NetVanta UC Server needs access. Typically, this is done by the 
network administrator either prior to installing NetVanta UC Server or during the installation process. 
Step-by-step instructions and additional details are provided in NetVanta Unified Communications Server 
Administrator Guide available from the ADTRAN Support Community 
(https://supportforums.adtran.com).

NetVanta UC Server opens mailboxes for each user by logging into the Exchange server private 
information store with the privileged account, and then opening individual mailboxes using that interface. 
This method is documented in the Microsoft Knowledge Base article titled How to Open Mailboxes with 
Privileged Access, available online at http://support.microsoft.com/kb/194627. This process allows 
NetVanta UC Server to act on behalf of all the users configured in NetVanta UC Server, allowing them to 
access the contents of their mailbox over the telephone, to place messages in their mailbox, or to send 
messages on their behalf. This is similar to many other applications, including the BlackBerry Enterprise 
Server.

The primary advantage of this technique is that no special software is needed on the Exchange server itself. 
This alleviates many concerns that Exchange server administrators might have, and allows the two systems 
to operate independently. As a result of this integration, NetVanta UC Server depends on the Exchange 
server operating correctly with the MAPI interface over the network connection between the two 
computers. 

Network Connection Guidelines and Considerations

Ideally, the network connection should be a local area network (LAN) with at least 100 megabits per 
second (switched) connectivity between the NetVanta UC Server and the Exchange server. In some 
circumstances, lower-rate connections (such as a wide area network (WAN)) may operate properly 
depending on the design of the network and the system usage patterns.

Integration with a remote or hosted Exchange server must take the following into consideration:

• Network link reliability (especially for WANs).
• Bandwidth and packet latency. Bandwidth requirements also affect latency and reliability (excessive 

packet loss or latency could cause the NetVanta UC Server to falsely detect loss of connectivity to the 
Exchange server)

https://supportforums.adtran.com/docs/DOC-7379
https://supportforums.adtran.com/docs/DOC-7379
http://support.microsoft.com/kb/194627
http://support.microsoft.com/kb/194627
http://support.microsoft.com/kb/194627
https://supportforums.adtran.com
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Integration Behavior

Message Storage and Retrieval

In order to create voice and fax messages within a mailbox or to send such messages to users, the NetVanta 
UC Server creates IPM.Note (standard email message) derived messages with custom message classes. 
This allows Outlook forms to be installed in an end user's Outlook environment and display a custom user 
interface for each of these message types. Without the custom forms, the messages appear as email 
messages with attachments. 

When accessing messages over the telephone user interface, the NetVanta UC Server will query the 
Exchange server for message counts of new messages (voice, fax, and email) and saved messages (voice, 
fax, and email), and will enumerate messages within the mailbox to play them to the user. In addition, the 
user can forward or reply to messages, causing the relevant new messages to be created and delivered 
accordingly. 

Contact matching

Incoming caller telephone numbers are matched to a user's personal contacts. The contact information is 
used for NetVanta UC Server features such as:

• Playing one-time messages to specific callers.
• Transferring callers based on contact matches.
• Performing notifications (active message delivery, pager notification, email notification) based on 

contact matches.
• Diverting callers within a service using the Flow Control element.
• Placing the matched contact information in the subject of voice and fax messages.

When an incoming call arrives, a contact-matching query is started against the associated user's personal 
contacts. If this query does not complete within a short period, the call answering behavior continues as 
though no contact match had been made. Matches that complete at a later time are still taken into account 
when storing messages. No attempt is made to determine whether a successful match is unique or not.

Mailbox Monitoring for Message Waiting Lights

The NetVanta UC Server also supports monitoring a mailbox for changes to that mailbox so that message 
waiting lights on telephones can be synchronized to the actual state of messages in a user's mailbox. To do 
this, the NetVanta UC Server opens each mailbox that is to be monitored and registers for events on the 
inbox of that mailbox. This is similar to many other applications, including the BlackBerry Enterprise 
Server.

Each mailbox event for voice and fax messages (not email messages) will result in an approximately 
600-byte message from the Exchange server to the NetVanta UC Server and approximately 1200 bytes 
from the NetVanta UC Server to the Exchange server.
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Network Bandwidth

Local Exchange Server Connectivity

Ideally, the connection between the NetVanta UC Server and the Exchange server should be a 100 
megabits per second switched connection or faster. It is preferable to have the servers co-located for 
optimal performance and response times, as well as closely connected on the Ethernet network.

Remote Exchange Server Connectivity

Generally, it is not possible to recommend bandwidth requirements for a remote or hosted Exchange server 
environment without understanding the nature of all the IP traffic that is traversing the WAN or public 
Internet connection. When looking at bandwidth availability, ensure that both the uplink and downlink 
speeds are used. In the case of asymmetrical broadband WAN or public Internet connections, ensure that 
you use the slower of the two speeds since that will be the limiting factor.

In assessing the use of a remote Exchange server, the following questions must be answered:

• How many Outlook users will be supported by the remote or hosted Exchange server?
• How many messages on average are received by users?
• What are the average sizes of email messages for users?
• What other applications will be using the same connection that connects the NetVanta UC Server to the 

remote or hosted Exchange server? These applications can include:
 Web browsers
 Website hosting server (specifically file uploads and downloads) 
 FTP clients or servers
 File-sharing (network file shares or other technologies)
 Voice over IP (VoIP) telephony (remote workers with IP telephones)
 Remote desktop sessions
 Any other WAN or Internet-related traffic
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Bandwidth Usage

The NetVanta UC Server, by default, will compress each voice message using Global System for Mobile 
Communications (GSM) compression. The size of the WAV file is approximately 100 kilobytes per 
minute. The following table shows the size of the files and sizes of data exchange with the Exchange 
server. A typical voice message is 30 seconds in length.

Table 1.  Bandwidth Usage

30 50 70 < 30

60 100 120 < 30

120 200 230 < 30

300 500 525 < 50

The direction of transfer depends upon whether the message is being saved (recorded) or retrieved (played 
back). In the case of recording a voice message, the direction will be from the NetVanta UC Server to the 
Microsoft Exchange server. For messages being played back to a unified messaging subscriber, the 
direction is from the Exchange server to the NetVanta UC Server.

Most organizations with fewer than 100 users can expect to reserve 200 kilobytes per second during peak 
periods of unified messaging activity. 

If bandwidth is unavailable during message playback, the caller will experience a delay over the telephone 
user interface when listening to a voice, fax, or email message. As a result, it may be desirable to establish 
quality of service characteristics on the network link based on the information in Table 1 on page 5 and a 
customer needs analysis to create predictable behaviors.

Users can also change the audio encoding/compression using Options in the NetVanta UC Client. This will 
affect message size.

Mailbox monitoring also increases bandwidth usage. Each mailbox event for voice and fax messages (not 
email messages) will result in an approximately 600-byte message from the Exchange server to the 
NetVanta UC Server and approximately 1200 bytes from the NetVanta UC Server to the Exchange server.

Reliability Requirements for Remote Exchange Server Connectivity

The NetVanta UC Server is designed to take into account loss of connectivity to the Microsoft Exchange 
Server due to network outages or required maintenance operations. The NetVanta UC Server monitors the 
connection by attempting to read a small amount of data from the mailbox associated with the service 
account every five minutes. If the NetVanta UC Server is unable to read this data, it flags the connection as 
having been lost, and disconnects and attempts a reconnection. Disconnecting involves releasing the MAPI 
interfaces and objects, then un-initializing MAPI. Reconnecting attempts to re-establish the required 
connection objects. If no connection is established, the NetVanta UC Server will attempt the connection 
periodically until connection is re-established or the NetVanta UC Server is reconfigured.

Message length 
(seconds)

Size of WAV file 
(kilobytes)

Direction of transfer of 
the voice message 

(kilobytes)

Opposite direction of 
transfer of the voice 
message (kilobytes)
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In addition, the NetVanta UC Server tracks failed operations against mailboxes in an attempt to detect 
connection loss as early as possible. When an error occurs, the NetVanta UC Server flags the connection as 
possibly disconnected. It then immediately schedules a connection check as documented above.

When the connection to the Exchange server is unavailable, the NetVanta UC Server buffers incoming 
messages for users. These messages are delivered as soon as possible after the connection is restored to the 
Exchange server. In the case where a user calls in to the NetVanta UC Server to check their messages over 
the phone, and Exchange server is unavailable or does not respond within four seconds, the NetVanta UC 
Server will play a message to the caller indicating that their mailbox is currently unavailable and that they 
should check their messages at a later time.

Setting the Closest Global Catalog Server

When Outlook is used as a MAPI client, NetVanta UC Server connects via Outlook to the Microsoft 
Exchange Server. By default, a MAPI client connects to the same global catalog server as the Exchange 
server. This can cause connectivity problems if the Exchange server is on a different site than the NetVanta 
UC Server (for example, if the Exchange server is on a hosted site). To prevent connectivity problems, 
change the registry of the NetVanta UC Server so Outlook can identify and use the closest global catalog 
server. For more information, refer to the Microsoft Knowledge Base article titled How to Configure 
Outlook to a Specific Global Catalog Server or to the Closest Global Catalog Server, available online at 
http://support.microsoft.com/?kbid=319206.

To change the registry of NetVanta UC Server, follow these steps:

1. Log on to the machine where the NetVanta UC Server is configured. Use the NetVanta UC Server 
Application Services account credentials. If necessary, use the following procedure to determine the 
user name of the account.
 Navigate to Start > Control Panel > Administrative Tools > Services. The Services window 

appears.
 Scroll down to NetVanta UC Server Application Services. The user name is listed under 

Log On As.
2. Navigate to Start > Run.
3. In the Open box, enter regedit.exe, and then select OK.
4. Back up the registry keys:

 In the File menu, select Export. The Export Registry File window appears.
 Under Export range, select All.
 In the File name field, enter the file name of the backup file and select Save.

5. Locate and then select the following key in the registry:

HKEY_CURRENT_USER\Software\Microsoft\Exchange\Exchange Provider 

You may have to create the registry path.

http://support.microsoft.com/?kbid=319206
http://support.microsoft.com/?kbid=319206
http://support.microsoft.com/?kbid=319206
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6. In the Edit menu, select Add Value, and then add the following registry values:

Value name: Closest GC 

Data type: REG_DWORD 

Radix: Hexadecimal

Value data: 0x00000001 

7. Quit the Registry Editor.
8. Restart the application service.

Troubleshooting Mailbox Failure to Open Errors

If the MAPI client has exceeded the limit for the maximum number of allowed connections, Exchange 
mailboxes can fail to open even though the Exchange server appears to be in a connected state and service 
account permissions are correct.

Behavior

The following is a list of errors you might experience when the MAPI client has exceeded the number of 
allowed connections:

• NetVanta UC Server was once able to open mailboxes; however, it is no longer able to open mailboxes, 
even though the Exchange server appears to still be connected. Consequently, users are unable to listen 
to messages using the TUI and receive a voice error message when attempting to do so.

• An error similar to the following appears in the swlog.txt file located in the ADTRANLogs folder 
(C:\ADTRANLogs by default): 

“(MExchangeManager::InThread_OpenMailbox) Failed to log in to mailbox" with reference to  
MAPI error code 8004011d ‘MAPI_E_FAILONEPROVIDER’.

• The operating system’s event viewer reports closing the MAPI session because it exceeded the 
maximum number of allowed server objects. 
 The report for exceeding the maximum number of server objects resembles the following: 

Closing Mapi session "/o=Organization/ou=Administrative Group/cn=Recipients/cn=user" 
because it exceeded the maximum of 250 objects of type "objtMessage".

 The report for exceeding the maximum number of concurrent connections to Exchange resembles 
the following: 

Closing Mapi session "/o=Organization/ou=AdministrativeGroup/cn=Recipients/ 
cn=Recipient" because it exceeded the maximum of 32 objects of type "session".

Solution

If you observe errors consistent with those outlined in Behavior on page 7, it is likely that the MAPI client 
has exceeded the maximum number of allowed connections. Follow the steps in the proceeding sections to 
resolve Exchange mailbox opening failures.
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Updating the Registry

1. On the NetVanta UC Server system, open the Registry Editor (regedit.exe) and navigate to 
HKEY_CURRENT_USER > Software >Microsoft > Windows NT > CurrentVersion > Windows 
Messaging Subsystem > Profiles > MS Exchange Settings > 13dbb0c8aa05101a9bb000aa002fc45a 
using the folders in the left pane of the Registry Editor. The key should already exist on NetVanta UC 
Server system. 

2. It is likely that a default value of “00036604”=hex:02,00,00,00 already exists for this registry key entry. 
If this default value exists for the registry key, proceed to Step 5 below. If a default value does not exist, 
proceed to Step 3 below.

3. Once you have selected the registry key, right-click in the right pane of the Registry Editor and select 
New > Binary Value from the drop-down menu to create a new binary value entry within the registry. 

4. Right-click the newly created entry, and select Rename from the drop-down menu. Rename the entry 
00036604. 

5. Right-click the value, and select Modify from the drop-down menu. The Edit Binary Value window 
will appear. 

6. Enter 06 00 00 00 in the Value data field.

Disabling Client Throttling for the Service Account

NetVanta UC Server requires continuous access to multiple Exchange mailboxes in a typical installation. 
Microsoft Exchange Server 2010 and later implement a default throttling policy that limits the number of 
simultaneous connections to Exchange. It is recommended to increase the throttling value to allow 
NetVanta UC Server to make as many connections as possible to Exchange Server. To remove client 
throttling on the NetVanta UC Server service account, follow these steps:

1. For Microsoft Exchange Server 2010, access the Microsoft Exchange Management Shell by navigating 
to Start > Programs > Microsoft Exchange Server 2010 > Exchange Management Shell. 

For Microsoft Exchange Server 2013, access the Microsoft Exchange Management Shell by navigating 
to Start > Programs > Microsoft Exchange Server 2013 > Exchange Management Shell. 

2. For Microsoft Exchange Server 2010, enter the following command to create a new throttling policy 
called UCPolicy with all client throttling disabled:

New-ThrottlingPolicy UCPolicy -RCAMaxConcurrency $null -RCAPercentTimeInAD $null 
-RCAPercentTimeInCAS $null -RCAPercentTimeInMailboxRPC $null -EWSMaxConcurrency $null 
-EWSPercentTimeInAD $null -EWSPercentTimeInCAS $null -EWSPercentTimeInMailboxRPC $null 
-EWSMaxSubscriptions $null -EWSFastSearchTimeoutInSeconds $null -EWSFindCountLimit $null

For Microsoft Exchange Server 2010 SP1 through SP3, enter the following command to create a new 
throttling policy called UCPolicy with all client throttling disabled:

New-ThrottlingPolicy UCPolicy -RCAMaxConcurrency $null -RCAPercentTimeInAD $null 
-RCAPercentTimeInCAS $null -RCAPercentTimeInMailboxRPC $null -EWSMaxConcurrency $null 
-EWSPercentTimeInAD $null -EWSPercentTimeInCAS $null -EWSPercentTimeInMailboxRPC $null 
-EWSMaxSubscriptions $null -EWSFastSearchTimeoutInSeconds $null -EWSFindCountLimit $null 
-CPAMaxConcurrency $null -CPAPercentTimeInCAS $null -CPAPercentTimeInMailboxRPC $null
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For Microsoft Exchange Server 2013 SP1, enter the following command to create a new throttling policy 
called UCPolicy with all client throttling disabled:

New-ThrottlingPolicy UCPolicy -OwaMaxConcurrency Unlimited -EWSMaxConcurrency 
Unlimited -EWSMaxBurst Unlimited -EWSRechargeRate Unlimited -EWSCutoffBalance 
Unlimited -EWSMaxSubscriptions Unlimited -RcaMaxConcurrency Unlimited -RcaMaxBurst 
Unlimited -RcaRechargeRate Unlimited -RcaCutoffBalance Unlimited -CpaMaxConcurrency 
Unlimited -CpaMaxBurst Unlimited -CpaRechargeRate Unlimited -CpaCutoffBalance Unlimited

3. Enter the following command to apply the UCPolicy throttling policy to the NetVanta UC Server 
service account. The <service account> variable should be replaced with the name of the NetVanta UC 
Server service account.

Set-Mailbox -Identity <service account> -ThrottlingPolicy UCPolicy

In the following example, the service account is UC.Server@adtran.com:

Set-Mailbox -Identity UC.Server@adtran.com -ThrottlingPolicy UCPolicy

Modifying Session Limits for Exchange 2013 SP1

For Exchange Server 2013 integrations, additional registry modifications may be required for large user 
deployments and call volume scenarios. To exceed the session limits imposed by Exchange Server by 
default, the following steps are required using the registry editor: 

1. On the Exchange Server, open the Registry Editor (regedit.exe).
2. Navigate to the following location in the registry:

HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > Services > MSExchangeIS > 
ParametersSystem

3. Create or edit the following dword values in the ParametersSystem registry key:

"DatabaseType"=dword:00000000 
"Maximum Allowed Sessions Per User"=dword:000007d0 
"Disable Session Limit"=dword:00000001 
"Maximum Allowed Service Sessions Per User"=dword:000007d0

Ensure your registry is backed-up prior to making any modifications.

Please note that registry setting changes will only apply if the Exchange Server system is 
restarted or the Exchange Information Store service is manually restarted via 
services.msc.
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Increasing the Maximum Open Server Objects on an Exchange Server System

If an error event indicates that a MAPI session tried to open more than the maximum number of objects 
that are allowed, it may be necessary to increase the default settings of one or more of the server object 
session limits on the Exchange server. The limits can be modified in the registry on the Exchange server 
system. Several object types can be modified: objtMessage, objtFolder, and objtFolderview. To 
determine which server object type exceeded its limit, refer to the last bullet in Behavior on page 7. Object 
types that should be modified are those that have exceeded the maximum limit for server objects.To add or 
modify these object types, follow these steps:

1. On the Exchange server system, open the Registry Editor (regedit.exe) and navigate to 
HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > Services > MSExchangeIS > 
ParametersSystem using the folders in the left pane of the Registry Editor. The directory should 
already exist on NetVanta UC Server system. 

2. Right-click ParametersSystem, select New from the drop-down menu, and select Key to create a new 
registry key.

3. Right-click the newly created registry key, and select Rename from the drop-down menu. Enter 
MaxObjsPerMapiSession for the key name.

4. Right-click MaxObjsPerMapiSession, select New from the drop-down menu, and select DWORD 
value.

5. Right-click the name of the newly created DWORD entry, and select Rename from the drop-down 
menu. Enter the name of the server object type whose maximum limit you would like to increase. For 
example, objtMessage.

6. Right-click the name of the entry, and select Modify from the drop-down menu. The Edit DWORD 
Value window appears.

7. In the Base section of the Edit DWORD Value window, select Decimal to allow input in the Value 
data field in base 10 format.

8. In the Value data field, enter the number of objects that you want to limit the server object type, and 
then select OK.

Restarting Microsoft Exchange Information Store and ADTRAN NetVanta UC Server 
Application Services

After increasing server object limits, you must restart the Microsoft Exchange Information Store Service 
and ADTRAN NetVanta UC Server Application Service for the changes to take effect. To restart these 
services, follow these steps:

1. In the computer’s Start menu, select Run.
2. In the Open field, enter services.msc, and select OK. The Services window appears.
3. In the Services window, scroll to the Microsoft Exchange Information Store service.
4. Right-click Microsoft Exchange Information Store Service, and select Restart from the drop-down 

menu to restart the service.
5. Scroll to the ADTRAN NetVanta UC Server Application Service.
6. Right-click ADTRAN NetVanta UC Server Application Service, and select Restart from the 

drop-down menu to restart the service. 
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